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END-USER SOFTWARE LICENSE AGREEMENT - Dostek DNC/32TM

This Dostek End-User License Agreement is a legal agreement between
you (an individual or legal entity) and Dostek Incorporated for the
Software Product know as "Dostek DNC/32". The Software Product
includes the computer software and data files, and the printed and
on-line documentation. By installing or using the Software Product, you
agree to the terms of this agreement. If you do not agree to the terms of
this agreement, you may return the Software Product for a refund within
30 days of purchase.

COPYRIGHT

All title and copyrights in and to all components of this Software Product
(and all copies thereof) and the accompanying printed materials are
owned by Dostek Incorporated. This Software Product is protected by
United States, Canadian and international copyright laws and treaties.
You may make an unlimited number of copies of the software, provided
that such copies are used only for internal purposes in compliance with
the terms of this License Agreement and provided that such copies are
not republished or distributed to any third party. You may make an
unlimited number of copies of the printed or on-line documentation,
provided that such copies are used only for internal purposes and are not
republished or distributed to any third party. 

SOFTWARE PRODUCT LICENSE

This Software Product is licensed (not sold). This License Agreement
grants you the following rights:

1. Use of Software Product. Dostek grants you a non-exclusive license to
install copies of the Software on any number of computers provided that
the Software may be used on only one computer at any time for each
license purchased. A license for the Software may not be shared or used
concurrently on different computers.

2. Transfer. You may permanently transfer all of your rights under this
License Agreement according to the following provisions: (a) you transfer
the entire Software Product, including all component parts, media,
printed materials, any upgrades, and this License Agreement; (b) the
recipient agrees to the terms of this License Agreement;  (c) you do not
retain any copies of the Software Product or any component parts,
including any upgrades received for the Software Product; (d) the
Software Product is not labeled "Not for Resale" or "Demonstration
Copy".

3. Demonstration Copies. You may not resell or otherwise transfer the
Software Product if it is labeled "Not for Resale" or "Demonstration
Copy".

4. Components. The Software Product is licensed as a single product,
and its component parts may not be separated for transfer or for use on
more than one computer.

5. Rental or Lease. You may not rent, lease, or lend the Software
Product.

6. Reverse Engineering. You may not reverse engineer, de-compile or
disassemble the Software Product.

7. Termination. Without prejudice to any other rights, Dostek may
terminate this License Agreement if (a) you fail to comply with the terms
and conditions of this License Agreement, or (b) you fail to comply with

the terms of the Sales Invoice or Agreement of Sale for the Software
Product as issued by Dostek Incorporated or by an authorized Dostek
re-seller. On termination of this License Agreement by either party, you
must destroy all copies of the Software Product and all of its component
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Agreement (if any) provided with the upgrade.

9. This License Agreement is governed by the laws of the Province of
Ontario, Canada.

LIMITED WARRANTY

Dostek warrants that the Software Product will perform substantially in
accordance with the accompanying documentation for a period of ninety
(90) days from the date of receipt. Dostek will make every reasonable
effort to correct any problem issues. This Limited Warranty is void if
failure of the Software Product results from abuse, improper application
or accident.

LIMITATION OF LIABILITY

Reasonable care has been taken in the design and preparation of the
Software Product. To the maximum extent permitted by law, in no event
shall Dostek Incorporated be liable for any indirect, special, incidental or
consequential damages whatsoever (including, without limitation,
damages for loss of business information, business interruption,
business profits, or any other loss) in connection with or resulting from
the use or the inability to use the Software Product. Dostek's entire
liability under any provision of this License Agreement shall be limited to
the amount actually paid by you for the Software Product.

NO OTHER WARRANTIES

Dostek Incorporated disclaims all other warranties and conditions, either
express or implied, including, but not limited to, implied warranties of
merchantability and fitness for a particular purpose.

Please contact Dostek Incorporated if you have any questions concerning
this License Agreement.
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Welcome to Dostek DNC, a versatile and easy to use CNC program management and
DNC communication program designed to work with the 32-bit Windows operating
systems. 

This manual explains how to install and configure the Dostek DNC software, and how to
connect machine tools and other devices to the computer. 

Refer to the Dostek DNC Getting Started Guide for an overview of Dostek DNC and
detailed installation instructions.

Refer to the Dostek DNC User Guide for detailed information about using Dostek DNC.

To prepare the Dostek DNC software for use, follow these steps:

Section 3.6q make backup copies of configuration files . . . . . . . . . . . . . .

Section 5.2q test communication . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 4q configure device communication parameters . . . . . . . . . . . .

Section 5.1q connect devices (CNCs, etc.) to the computer . . . . . . . . . . .

Section 3.5q create menu and desktop shortcuts . . . . . . . . . . . . . . . . . . .

Section 3q configure application settings . . . . . . . . . . . . . . . . . . . . . . .

Section 2.2q review configuration basics . . . . . . . . . . . . . . . . . . . . . . . . .

Section 2q review software features, organization and security issues . .

Getting
Started
Guide

q install software and software license . . . . . . . . . . . . . . . . . .

 



1 Technical Support

Telephone technical support is free for a period of 90 days from date of purchase. Free
technical support is always available by email (see below).

An annual Priority Technical Support subscription, which includes telephone support and
downloading of software updates and technical documents, is available by annual
subscription (contact Dostek for details).

Before contacting Dostek, please review the appropriate items on the following
checklists:

If you experience difficulty installing Dostek DNC:

q if you are using Windows NT or are installing the software on a network file
server, be sure to use an account with administrator privileges

q ensure that all other Windows applications are closed before installing Dostek
DNC

q carefully follow the installation instructions provided in this manual and on the
computer screen

q try to uninstall (if possible) and then reinstall Dostek DNC

If you experience difficulty transferring data between the computer and CNC machines,
refer to Configuration Guide, Section 5.2, "Testing Communication".

If you experience an unrecoverable error:

q before doing anything else, ensure you have a current backup copy of your
data and your Dostek DNC configuration files

q close all applications and restart Dostek DNC

q restart the computer

Contact Dostek

www.dostek.com/support.htmInternet

519-741-8669Facsimile

519-742-5721
8am - 5pm, M-F, EST

Telephone

support@dostek.comEmail
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2 Configuration Overview

Dostek DNC is configured by setting two types of configuration parameters:

v software options such as file locations and security options

v device configuration parameters such as baud rate and parity

Configuration settings are stored in files located in the “Settings” sub-folder of the Dostek
DNC application folder. Application configuration settings are stored in file DDNCW32.INI,
and device settings such as baud rate and parity are stored in Device Configuration
Parameter files (“.DCP” file extension). A separate device configuration file is usually
created for each CNC or other device connected to the computer.

Most configuration data is stored in files rather than the system registry to simplify
backup or copying of settings to another computer (such as when a computer is replaced
or upgraded). Many user preference settings, however, are stored in the system registry
to permit each user to store a different profile (Windows user profiles are enabled by
selecting Control Panel, Passwords, User Profiles). 

The Dostek DNC Configuration application (DConfig) is used to configure device
configuration files and many system application options. Other application options are
configured by choosing “Preferences” or "Options" from the application’s menu. Some
preferences, such as form size and location, are automatically stored in the system
registry.

DConfig features two configuration modes. Global configuration mode is used to edit
Dostek DNC application configuration settings, and Device configuration mode is used to
configure device configuration parameter files. The configuration mode is changed by
clicking the “Global” button on the toolbar or by choosing “Global Settings” from the File
menu. When Global configuration mode is in effect, the Global toolbar button appears
depressed and the Global Settings menu item is checked.

DConfig is started in any of the following ways:

v choose “Dostek DNC Configuration” on the Windows Start menu
v choose “Configure Dostek DNC” or “Configure Devices” on the Dostek DNC File

Manager “Supervisor” menu
v choose a Dostek DNC File Manager QuickButton you create
v choose a Windows desktop shortcut you create

Special Character Symbols

Many Dostek DNC settings accept special character symbols for specifying non-printable
characters. For example, you can configure Dostek DNC to send an ASCII DC4 control
code (sometimes used as a "Reader Off" command) to the CNC after a file is sent by
specifying "^T" in the Transmit Suffix setting. A complete list of special character
symbols is provided in Appendix A at the back of this division of the manual.
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2.1 Using Option Setting Forms

Option setting forms such as the Global General form illustrated in Figure 3 use the
following "controls" for specifying configuration options:

Pick one choice by clicking on the button or it's label.Option Button

Change the option by clicking on the check box or it's
label.

Check Box

Click the down arrow and click on an item in the list.List Box

Type a value. The number and type of characters (letter,
number, symbol) you can enter depends on the option.
ASCII control characters can be included in some text
boxes by typing a caret symbol (^) followed by the
appropriate character (list provided in Appendix A).

Text Box

2.2 Saving and Restoring Configuration Files

Use the Configuration Manager wizard (Section 3.6) to save and load backup copies of
configuration files to and from a diskette, network drive or local hard drive. When multi-
ple computers are used, the set of Dostek DNC configuration files used by each
computer can be stored as a separate configuration "collection".

The Configuration Manager wizard simplifies system maintenance by quickly loading a
saved configuration collection whenever a computer is moved or replaced.

2.3 Security

Dostek DNC provides security features to:

v restrict access to only files stored in specific drives or folders
v restrict access to only files of a specific type (file extension)
v restrict use of Dostek DNC commands that modify files or folders
v restrict modification of Dostek DNC configuration settings and preferences

When Dostek DNC is initially installed, security is disabled and users have full access to
all Dostek DNC commands as well as all available resources, including drives, files and
printers on the local computer and any connected network computers.

To enable Dostek DNC security, check the “Enable Security” check box on the Configu-
ration program’s Security tab (Section 3.2), and enter a password.

The File Manager "Supervisor Mode" permits full access to all Dostek DNC commands
and features. To activate Supervisor mode:

v choose Supervisor Mode from the File Manager File menu, or click the security
icon on the File Manager toolbar, and enter the Supervisor password

v start the Configuration program and enter the Supervisor password when
prompted

v choose a protected command or feature and, when the password form is
displayed, check the "Log on to Supervisor mode" check box and enter the
Supervisor password
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All security features are disabled while Supervisor mode is active. To terminate Supervi-
sor mode ("log off"), choose Supervisor Mode from the File Manager File menu, click the
security icon on the File Manager toolbar, or close all open Dostek DNC applications.

2.3.1 Reset Password

If you forget the password or the security settings become corrupted (for example, by
attempting to change the settings with a text editor), you may not be able to operate the
Dostek DNC software. To clear the password and security settings:

v insert the Dostek DNC CD-ROM in the computer’s CD-ROM drive

v click Start, select Run, and type the command: “D:\Tools\DUnlock” (substitute
your CD-ROM’s drive letter for D:)

For security reasons, do not copy the DUnlock utility program to your computer’s hard
drive, and ensure the CD-ROM is stored in a secure location. 

2.3.2 Security Precautions

To prevent unauthorized access or modification of data, consider the following general
security measures:

q Control physical access to the computer.

q Use the Windows security features to restrict access to the computer and
network resources.

q Use a security utility such as Cetus Storm Windows to restrict use of Windows
95 commands and features.

q Consider setting file attributes of original files to "Read Only".

q Use non-obvious passwords. Passwords that are six or more characters in
length using a combination of letters and numbers are most secure.

q Do not disclose passwords to unauthorized users.

q Change passwords frequently.

q Use the Dostek DNC security options.

q Configure Dostek DNC “Root Folders” (Section 3.1.1) to restrict user access to
specific drives or folders.

q The Dostek DNC Editor restricts access to specific folders according to the
"Root Folders" setting, but allows access to all files in the folders. Store
sensitive files elsewhere.

q Some security-related configuration settings, such as file locations, are stored
in the DDNCW32.INI configuration file. A knowledgeable user with access to the
configuration file may be able to modify settings using a file editor.

q Store the Dostek DNC software CD in a secure location to prevent use of the
security "unlock" utility (Section 2.1.1).

Configuration Guide  Page 5

 



q to enable automatic selection of device communication
parameters according to the file folder (Section 3.4.1), check
"Match device to folder" on the Communication Options tab 

q specify a receive file naming option (Section 3.4.2)

q to distinguish all automatically named received files with a file
name prefix, refer to Section 3.4.3

q specify a default file extension for received files (Section 3.4.3)

q to omit extraneous text from being transmitted (such as file
headers inserted by a post processor), refer to Section 3.4.4

Communication
Options

q to share a communication port using a Dostek 208/216
CommSwitch, check "CommSwitch" on the Communication
Options tab (Section 3.4)

q to use a multi-port communication card, install the card and the
vendor's software drivers

Communication
Ports

q to implement a File Archive, refer to Section 3.1.2File Archive

q specify security options (Section 3.2)

q to restrict access to specific file folder(s), specify Root Folders
(Section 3.1.1)

q to restrict access to specific file type(s), specify File Filters
(Section 3.3) and choose "File Filter" from the File Manager
"View" menu

Security

q to use network resources, set up user accounts and file and
printer resources on the file server(s)

q to print on a network printer, set up the printer on the local
computer 

Network

q organize files (Section 2.3)Files

Table 1 - Application Configuration Checklist
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3 Configure Application Options

To modify Dostek DNC application options such as file locations and security options,
start the Dostek DNC Configuration program (DConfig) and choose the “Global” configu-
ration mode (if necessary) by clicking on the Global icon in the toolbar or by choosing
"Global Settings" from the File menu.

Application configuration option are displayed on a tabbed form as indicated by Figure 1
and described in the following paragraphs.

Figure 1 - Application Settings Form

Options and file locations for event logging.Event Log

Related document specifications (for use with the "View Related
Document" command).

Documents

Communication options.Communication

File filter specifications.File Filters

Security options.Security

File locations, computer identification and Configuration Manager
button.

General

Configuration OptionsTab

Table 2 - Application (Global) Configuration Tabs
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3.1 Global General Options

Text fields and Browse buttons on the General tab are used to specify file locations as
described in Table 3. To configure a file location, type a drive and folder specification
into the text field (for example, “C:\NC Programs”), or click the appropriate Browse or
Change button to select a file location by browsing through a list of drives and folders.

You can specify network resources by specifying a mapped drive or UNC name
("\\Server\Path\File"),  or by browsing the Network Neighborhood.

If specified, this folder is the root folder to which the Dostek DNC
File Manager “Archive Store” command writes selected files. If
this field is blank, files are stored to the specified Archive Folder.
(Section 3.1.2)

Archive Store
Folder

If specified, this folder is the root folder from which the Dostek
DNC File Manager “Archive Retrieve” command retrieves files. If
this field is blank, the File Archive commands are disabled.
(Section 3.1.2)

Archive Folder

If specified, files received from CNC machine tools are stored in
this folder or one of it’s sub-folders. If blank, the Receive Folder is
set initially to the first folder specified in “Root Folders”. To ensure
received files can be accessed for viewing, editing or transmitting,
the Receive Folder must be a sub-folder of a Root Folder.

Receive Folder

To restrict access to specific drives or folders, enter the path for
each root folder separated by a semicolon character, or click the
Change button to manage root folders using the Root Folder
Manager. To permit access to all local drives and mapped network
drives (subject to network security restrictions), leave the Root
Folders field blank or choose "My Computer".

Root Folders

You can assign a name to the collection of configuration files used
by each computer. Click the Manager button to start the
Configuration Manager wizard to save, load, copy or delete a
configuration "collection" to or from a diskette, file server or local
hard drive. (Section 3.6)

Configuration
Management

DescriptionItem

Table 3 - Global General Options

3.1.1 Root Folders

User access is restricted to the specific drives and folders specified in the “Root Folders”
field, as indicated in Table 3.

For security reasons, Dostek DNC permits copying of files to or from a diskette only if
the diskette drive is specified as a root folder. If files must frequently be copied to or
from diskette, include the diskette drive in the root folder list.
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3.1.2 File Archive

Dostek DNC is often used in a network environment where CNC program files are stored
on a file server. To prevent machine down time, however, you may prefer to store files
on the computer’s local hard drive where they can be loaded even if the network is
down. The File Archive feature lets you implement a system where the master copy of
CNC program files are stored on a file server (the "file archive") and a working copy of
some or all of the files is stored on the shop-floor computer (the "working folder"). 

Some Dostek DNC users store all files on both the server and the shop-floor computers
and use the File Manager's Archive command to retrieve new or updated files from the
server. Other users prefer to keep current files (work in process) on the shop-floor
computer, and restrict access to other files (by requiring the Supervisor password to use
the Archive Retrieve command).

vno down time due to network problems

v restricted access to master files

vshop-floor users work with a copy of the
original file, and can be prevented from
modifying the working copy

vshop-floor files are not updated when
master files are added or changed, but
are easily updated by the Archive
Retrieve command

vonly one copy of files to manage

vdirect access to current copy of all files
at all times

File ArchiveDirect Server Access

To implement a file archive, specify the name of the Archive Folder on the Global
General tab. To store files uploaded by the Archive Store command to a different folder,
specify an Archive Store Folder (if blank, uploaded files are stored in the Archive folder).
The Archive Retrieve command searches both the archive folder and the archive store
folder. If a file is present in both locations, you can choose which file to retrieve.

Archive Sub-Folders

The file archive and working folder can be subdivided into
sub-folders to categorize files. Consider the folder arrangement
illustrated at right. The archive folder is "G:\NC\Archive", the
working folder is "C:\NC", and separate sub-folders are used to
categorize files by machine type. If the current folder is "Mill" (or
any of it's sub-folders) when the Archive Retrieve command is
used, Dostek DNC searches only the matching "Mill" folder in the
archive file area. This feature simplifies file searching and
prevents files from being copied (retrieved or stored) to a different
file category (folder).

When the Archive Search/Retrieve form is displayed, the name of
the matching folder is displayed in the form caption. If files are not categorized in
folders, or a matching folder is not found, Dostek DNC sets the search/retrieve folder to
the archive root folder. If the "Search sub-folders" check box is checked, one additional
level of folders is searched.
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3.2 Security Options

Check boxes on the Security tab specify which commands or operations are restricted as
described in Table 4. When Dostek DNC is initially installed, security is disabled. To
enable security, check the “Enable Security” check box and enter a new password.
Security options may be set only if security is enabled.

When a restricted command is chosen in any Dostek DNC application while security is
enabled, a form is displayed for the user to enter the Supervisor password. A check box
on the password form allows the user to optionally “log on” to Supervisor mode, remov-
ing all security restrictions until the user “logs off”. Otherwise, the password must be
entered each time a restricted command is chosen.

A Security icon appears on the toolbar of the File Manager application. This toolbar icon
displays the current security state, and may be clicked to “log on” to or “log off” from
Supervisor mode. The icon appears to be "depressed" while the user is logged on to
Supervisor mode, and appears as a “ghosted” image if security is disabled.

When checked, the Supervisor password is required to store files
to the Archive folder.

Archive Store

When checked, the Supervisor password is required to retrieve
files from the Archive folder.

Archive Retrieve

When checked, the Supervisor password is required to change
user preferences and display options.

Change
preferences

When checked, the Supervisor password is required to use the
Dostek DNC Configuration program (DConfig), or use File
Manager Options or Root Folders commands.

Change system
configuration

When checked, the Supervisor password is required to receive
files from machine tools or other devices.

Receive

When checked, the Supervisor password is required to modify
folders (create, delete, rename, move, etc.)

Modify folders

When checked, the Supervisor password is required to modify
files (delete, rename, edit, etc.).

Modify files

Click this button to enter a new Supervisor password.Change
Passwords

When checked, security is enabled and access to certain Dostek
DNC features and commands can be restricted by checking the
appropriate check box (described below).

Enable Security

DescriptionItem

Table 4 - Security Options Tab
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3.3 File Types

The File Types tab specifies files types for four categories of files, each represented by a
different icon. One or more file specifications can be entered if separated by the semico-
lon character (“;”). File specifications may not include a drive or path. The asterisk
character (“*”) is permitted as a “wild card” character. For example, the NC Files file
filter could be set to “O*.TAP;*.TXT” to include any file with the extension “.TAP” starting
with the letter “O” or any file with the extension “.TXT”.

The File Manager displays (and thereby permits access to) the specified file types
according to it's File Filter option setting. File filters can be used to restrict access to only
files of specific types (such as NC program files) for ease of use or to enhance security.

The Dostek DNC Communication application permits access to NC Files, Job Files and
Binary Files.

3.4 Communication Options

The Communication Options tab specifies the communication options listed in Table 5.

3.4.1 Match Device Configuration to Folder

When the “Match device configuration to folder" check box is checked, DDNC32
automatically selects a device configuration file that matches the current file folder. This
feature, referred to as "automatic device protocol selection", can save time as well as
prevent errors by ensuring that files in a particular folder are used only with specific
machine tools.

When a file is transmitted or received, DDNC32 searches the Settings folder for a device
configuration file whose name begins with any of the folder names in the file's path
specification. For example, if file “C:\NC\Mill\Base\O1234.TAP” is transmitted,
DDNC32 searches for a device configuration file whose name begins with “NC”, then
“Mill” and finally “Base”. If only one matching name is found ("Mill", for example), it is
automatically selected. If more than one matching name is found ("Mill 1" and "Mill
2", for example), DDNC32 lets the user choose any of the matching files. If no matching
device configuration files are found, DDNC32 lets the user choose any configuration file.

If the device configuration file includes text within square brackets, the text is ignored
when matching the device name. For example, "[A] Mill" and "[B] Mill" will both
match a folder named "Mill".
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When checked, lines that start with any of the specified characters
are not transmitted. Use this feature to omit comments such as file
headers inserted by CAM software. 

Omit lines...

The Default File Extension is applied to all received files whose
name does not already contain a file extension. The Extension
setting on the device Receive Options tab (Table 12) overrides
this setting. 

Default File
Extension

When automatic naming of received files is enabled, the Master
Name Prefix is inserted at the start of each file name. This feature
can be used to designate uploaded files or prevent replacement of
existing files (Section 3.4.2, Section 4.6).

Master Name
Prefix

Specify the default mode for automatic naming of received files
(Table 6). Check the “Permit operator...” check box to allow the
operator to change the mode. (Section 3.4.2 and Section 4.6)

Default Receive
File Naming

Mode

When checked, support for the Dostek 208/216 CommSwitch is
enabled, and a CommSwitch port selection field is added to the
device configuration “Port Settings” tab. When the 208/216
CommSwitch is used, RTS/CTS flow control may not be used.

Use Dostek
208/216

CommSwitch

When checked, automatic selection of a device configuration
parameter file based on the current file folder is enabled (Section
3.4.1).

Match device
configuration to

folder

DescriptionItem

Table 5 - Communication Options Tab

File name is determined by the content of the received data, and
all programs are combined into a single file using the first name
detected. Use this option to keep subprograms in the same file as
main programs.

AutoName:
Single

File names are determined by the content of the received data,
and a new file is opened each time a file name is detected.

AutoName:
Individual

The operator must specify a file name. If a name is not specified,
“Untitled” is used.

Manual

DescriptionItem

Table 6 - Receive File Naming Modes
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3.4.2 Automatic Naming of Received Files

The “Automatic Naming of Received Files” feature automatically names received CNC
part program files according to the program number or other identification (such as a
part number stored in a comment) output by the CNC. 

When more than one program is received, Dostek DNC can store each program in a
separate file or store all programs in a single file. If you usually store main programs and
subprograms in the same file, choose "Single" as the default file naming mode. If you
usually store main programs and subprograms in separate files, choose "Individual". If
you prefer to enter a file name manually, choose "Manual". Check the "Permit operator
to change mode" check box to permit the operator to change the file naming mode.

Automatic file naming can save time, reduce typing errors and (by using the Prefix or
Extension option) prevent accidental overwriting of original program files.

Automatic naming of received files is described in Section 4.6.

3.4.3 Default File Prefix and Extension

A prefix, suffix or file extension can be added to automatic file names to (a) distinguish
uploaded files from original files so the system administrator can keep track of program
changes or (b) prevent accidental overwriting of original program files. The exclamation
character (“!”) is often specified as a file prefix character so uploaded files automatically
appear first in the sorted list of file names. The File Manager Search command can be
used to locate uploaded files when a file name prefix is used.

A file extension can also be specified in each device configuration file. If the name of a
received file does not include a file extension, the extension is the device configuration
file is used. If the extension in the device configuration file is blank, the Default Exten-
sion on the Communication Options tab is used.

3.4.4 Transmit Options

The Dostek DNC Communication application can prevent extraneous text (such as a
program header inserted by your CAM post processor) from being transmitted to the
CNC. Lines that begin with any of the characters specified in the "Omit lines starting
with" option on the Communication Options tab are not transmitted.

More than one character can be specified. For example, specify "#*" to omit lines that
start with either "#" or "*". 

A similar "Remove lines" option is provided on the device configuration "Filtering" tab
(Section 4.3). If both options are specified, both are effective.
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3.5 Shortcut Manager

The Shortcut Manager provides a
convenient way to create or remove
Windows shortcuts for starting the
Dostek DNC software. To use the
Shortcut Manager, start the Dostek
DNC Configuration program and click
the Shortcut Manager icon or choose
“Shortcut Manager” from the Tools
menu.

Shortcuts can be created in or
removed from the following locations:

v Windows Desktop
v Windows Start Menu
v Windows Programs Menu
v Favorites folder
v Personal folder

To create or remove shortcuts, follow these steps:

1. Choose a shortcut location.

2. Enter a folder name if you wish to create a folder to contain the shortcuts
(for the Windows Start menu or Programs menu, creating a folder
produces a sub-menu).

3. Check or clear the appropriate check box to create or remove a shortcut
for each of the four Dostek DNC applications. Click the All button to
alternately check or clear all check boxes.

4. To change the name or command-line arguments for a particular shortcut,
click the corresponding Details button.

5. Click Apply or Close to implement the changes. Windows will take a few
seconds to update your system files. 

6. Repeat for each shortcut location you wish to modify.

Desktop shortcuts are created in the first available desktop location, and may be
rearranged by dragging the icon or by clicking the right mouse button on an empty area
of the screen and selecting Arrange from the menu.

The Windows Start menu is accessed by clicking the Start button on the Windows task
bar. The Windows Program menu is accessed by choosing “Programs” on the Windows
Start menu. 

If the Windows “User Profiles” feature is enabled (Passwords item in Control Panel), the
desktop and menu items may be specified for either the current user or for all users.
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3.6 Configuration Manager

The Configuration Manager wizard backs up and restores configuration files between the
Dostek DNC Settings folder and a diskette, network drive or local hard drive. When
Dostek DNC is used on multiple computers, the complete set of configuration files for
each computer may be stored in a separate configuration "collection" (folder).

To use Configuration Manager, click the "Manager" button on the system configuration
General tab (Section 4.1), and choose one of the four actions: Save, Load, Copy or
Delete. When saving, the collection of configuration files is stored in a folder named
according to the "Collection" field on the global general configuration tab, or "Untitled" if
the field is blank. Alternately, you may type a name in the "Folder" field when the
wizard's file selection panel is displayed (consider using the computer's network name as
the folder name). When loading, copying or deleting a previously saved collection, pick
the name of the collection from the "Folder" list on the file selection panel. 

One or two configuration collection backup locations may be specified by clicking the
Configure button on the wizard's location selection panel. Configuration collections are
typically stored on a diskette (see "License/Settings Disk" below) or a network file server.
You may Save to both locations simultaneously, or Copy collections between locations.

When replacing a computer, the Configuration Manager wizard lets you quickly configure
the Dostek DNC software by loading a previously stored configuration collection.

License/Settings Disk

A "License/Settings" diskette is supplied with Dostek DNC to provide a location to save a
backup copy of your configuration files and your customer license file. Use the Configu-
ration Manager wizard to copy configuration files, or choose "License" from the Dostek
DNC Configuration menu to load or save the license file. You can use a blank diskette in
place of the supplied disk or for an additional backup copy. Update the  License/Settings
disk any time you receive a new license file or update any configuration files.

Figure 2 - Configuration Manager
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q when you are finished configuring the system, and any time you
change the configuration, save all configuration files to the
Settings Diskette or a network file server using the
Configuration Manager (Section 3.6)

Backup Copy

q record relevant information (CNC parameter settings, cable
wiring, etc.) in each configuration file by clicking the Notes
button on the General tab (Section 4.1)

Notes

q to display operator instructions on the screen when Dostek DNC
is ready to transmit or receive, refer to Sections 4.4.3 and 4.5.3.

Operator
Instructions

q if your files contain text that must not be transmitted, choose
transmit filter options (Section 4.3)

Filter Options

q to configure Dostek DNC to wait until you execute a "read"
command on the CNC before starting to transmit, set the
Transmit Trigger option (Section 4.5.1)

Transmit Trigger

q to use Automatic Naming of Received Files, configure file name
parameters (Section 4.6)

Receive File
Naming

q Configure the FIFO port settings for each computer COM port
used with Dostek DNC (Section 5.2.8).

Computer COM
Port

q if you are using a Dostek 208/216 CommSwitch, select a
CommSwitch port on the Port Settings tab

q if you are using an electronic switch box, enter the command
required to set the switch port in the Transmit and Receive
"Initialize" fields (Section 4.3)

Electronic Switch

q create a separate device configuration file for each device if:
vyou are using a Dostek CommSwitch or an external electronic

switch box to connect multiple devices to a single port
vyou are using a multi-port communication card

q if you use a sample device configuration file supplied by
Dostek, click the Notes button on the General tab to view
configuration notes (Section 4.1)

Multiple
Configuration

Files

     

Table 7 - Device Configuration Checklist

Page 16 Dostek DNC



4 Configure Device Parameters

Device parameters such as baud rate and parity are stored in Device Configuration
Parameter files located in the Dostek DNC “Settings” sub-folder. A separate configura-
tion file is usually created for each device connected to the computer.

Long file names can be used for device configuration files. However, brief descriptive
file names are easier to use. 

To modify device configuration files, start the Dostek DNC Configuration program
(DConfig). If the DConfig “Global” configuration mode is active (the Global icon in the
toolbar appears depressed and a check mark appears beside the Global Settings item on
the File menu), switch to the device configuration mode by clicking the global icon or
choosing the Global Settings menu item.

Device configuration parameters are displayed on a tabbed form as illustrated by Figure
3 and described in the following paragraphs.

When started, DConfig opens all configuration files located in the Settings folder. To
select a specific file, click the file list box or the adjacent left/right (previous/next) arrow
buttons.

Figure 3 - Device Configuration Form
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4.1 Device General Options

The General tab displays the options listed in Table 8. 

An icon can be associated with each device. Choose one of the supplied icons, or create
your own using your icon editing program. Icons are stored in the "Graphics" folder.

Certain CNCs require a special handling option. For example, some Okuma OSP5000
CNCs require special formatting of the program number. To enable special processing
for a specific CNC model, choose from the “Special CNC” list.

Notes can be stored in the device configuration file by clicking the Notes button. Sample
device configuration files provided by Dostek use the Notes form to provide information
such as a cable diagram, CNC parameter settings and any additional setup instructions.

4.2 Port Settings

Choose the Port Settings tab to specify a computer communication port and configure
communication settings such as baud rate, data format and flow control. Port settings
are described in Table 9.

"Transmit" refers to sending data from the computer to the CNC. "Receive" refers to
sending data from the CNC to the computer.

Click the “Editor” button to modify parameters used by the Dostek
DNC Editor to reformat NC programs.

Editor

Click the “Notes” button to view or edit notes included in the
device configuration file (2,500 characters maximum).

Notes

Select “Normal” for most applications, or choose a CNC type from
the list to enable special software support. 

Special CNC

Select an icon to associate with each device configuration file.Icon

Enter a description of up to 40 characters in length. The device
description is displayed in the status bar on the Communication
application's Settings form and is visible as a "tool tip" on the main
form when the mouse is positioned over the device name

Description

DescriptionItem

Table 8 - Device General Options Tab
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When checked, different communication settings may be used for
transmit and receive operations. Transmit refers to sending of
data from the computer to the device.

Separate Settings

Select a flow control option to suit the device. Flow control must
be properly configured and tested to ensure reliable data transfer. 

When the Dostek 208/216 CommSwitch is used, RTS/CTS flow
control may not be used.

Flow Control

Select 1 or 2 stop bits. Select 2 stop bits for compatibility with all
devices. Select 1 stop bit to increase data throughput by up to 10
percent. 

Stop Bits

Select 7 or 8 data bits to match the device setting. (Refer to Data
Format above).

Data Bits

Select a parity setting to match the device parity setting. (Refer to
Data Format above)

Parity

Select a communication baud rate to match the device baud rate.Baud Rate

Select a data format suitable for the device.

Most CNC machine tools use ISO format (ASCII code with 7 data
bits and even parity). When ISO is selected, 7 data bits and even
parity are set automatically. (Note: some CNCs indicate a setting
of ISO with 8 data bits and no parity; this CNC setting is consistent
with the Dostek DNC ISO setting because ISO data is, by
definition, 7 data bits plus even parity (8 bits).

Choose Binary data format to disable all data filtering and
conversion. Binary format is automatically used to transmit any
file of a "Binary" type as designated by File Type options (Section
3.3).

Data Format

Enter the number of the Dostek 208/216 CommSwitch the device
is connected to. (This option is available only if the "Use
CommSwitch check box is checked (Table 5)).

CommSwitch
Port

Enter the number of the computer communication port to which
the device is connected. Computer port availability can be
checked by Start, Settings, Control Panel, System, Device
Manager, Ports (Windows 95, 98) or Control Panel, Ports
(Windows NT 4).

Comm Port

DescriptionItem

Table 9 - Port Settings Tab
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Specify text to transmit immediately after transmitting each file.Suffix

Specify text to transmit immediately before transmitting each file.Prefix

Specify text to transmit to the device after all data is transmitted
or received. Use the Close option to send commands to an
electronic switch or conversational CNC, or to solve data
"framing" problems (Section 4.3). The Close string is transmitted
only once, even if multiple files are selected to transmit.

Close

Specify text to transmit to the device before transmitting or
receiving any data. Use the Initialize option to send commands to
an electronic switch or conversational CNC, or to solve data
"framing" problems (Section 4.3). The Initialize data is transmitted
only once, even if multiple files are selected to transmit. 

Initialize

Select the end-of-block option to match the device. Most CNCs
require a Line Feed only.

End of Block

DescriptionItem

Table 10 - Formatting Options Tab

Block numbers that are longer than 4 digits are truncated to four
digits. For example, N12345 is transmitted as N2345.

Truncate block
numbers

Space characters are omitted from transmitted data. Space
characters within parenthesis ( ) are not affected.

Compress

Blank lines are omitted from transmitted data.Remove Blank
Lines

All non-printable characters are omitted from transmitted data and
removed from received data. When receiving, use this option to
omit extraneous characters output by a CNC, such as the null
characters used to produce a “leader” on a tape punch.

Remove control
characters

Comments beginning with a parenthesis character "(" are omitted
from transmission. All text from "(" to the end of the line is
omitted. Lines that start with "(" will be transmitted as a blank line
unless you also include "(" in the "Remove lines..." filter. Do not
use this filter option if your programs may contain comments in
the middle of a program block, such as "G28 (ZERO) X0".

Remove
comments

Lines that start with any of the specified characters are not
transmitted to the CNC. You can use this filter to omit comments
in the NC program file, such as those inserted by a CAD/CAM post
processor. 

Remove lines
starting with...

DescriptionItem

Table 11 - Filtering3 Tab
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4.3 Formatting and Filtering Options

Choose the Formatting and Filtering tabs to configure the options described in Tables 10
and 11. (Note: review "Special Character Symbols" on page 3)

Many CNCs require that received data be "framed" in a specific format requiring special
characters before or after the NC programs. Use the Initialize, Close, Prefix and Suffix
options to "frame" data when transmitting to the device. Following are some examples of
program format or framing problems and how they are corrected by setting Dostek DNC
formatting and filtering options.

Set Transmit Initialize to
"K^M" and Transmit Close to
"^Z". 

A CNC uses a conversational terminal port for
program loading and requires the user to type "K"
followed by Carriage Return before receiving the
program, and Ctrl+Z when finished

Set Transmit Close to "%",
and include "%" in Transmit
Filter "Remove lines..."
option.

A CNC requires a percent sign to indicate the end
of data, but stops reading if a percent sign is
present at the start of a program. 

Add "^J" to Transmit
Initialize.

To automatically detect EIA or ISO tape code, a
CNC discards received data until the first "end of
block" code is received. That is, it discards the first
line of text received from the computer, which may
be the first line of the program.

Set Transmit Close to
"%","^D" or "^R".

A CNC rejects received programs if not concluded
by, for example, a percent sign, EOT or DC4 code.

Set Transmit Initialize to
"^@@", "%" or "^R".

A CNC rejects received programs if not preceded
by, for example, tape leader (null characters), a
percent sign, or a DC2 code.

SolutionExample Problem

4.3.1 Transmitting Multiple Files

Formatting and filtering settings determine how multiple files are transmitted. Dostek
DNC can be configured to pause after each file or send all files without pausing. For a
typical CNC that requires a line feed before any data is received (to determine ISO or
EIA tape format), and a program stop code (%) at the end of data, configure formatting
and filtering options as follows:

Set device configuration to:
vTransmit Initialize = "^J"
vTransmit Close = "%^J"
v include "%" in "Remove lines..."
vclear "Pause between files" check box

(Transmit Options tab)
Press READ once on CNC to load all
files.

Set device configuration to:
vTransmit Initialize = "^J"
vTransmit Suffix = "%^J"
v include "%" in "Remove lines..."
vcheck "Pause between files" check

box (Transmit Options tab)
Press READ on CNC to load each file.

No pausePause between files
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4.4 Transmit Options

Choose the Transmit Options tab to configure options related to transmitting of files to
the CNC. (Note: review "Special Character Symbols" on page 3)

4.4.1 Transmit Trigger

When the Transmit Trigger option is enabled, Dostek DNC waits until the CNC is ready
before starting to transmit. Synchronizing communication in this way eliminates the need
to run back and forth between the computer and the CNC, even when transferring multi-
ple programs. You get the computer ready to send, then complete the transfer at the
CNC.

Choose one of the following Transmit Trigger options:

Transmit starts when the specified character is received
from the CNC.

Other

Transmit starts when the CNC turns on the signal
connected to the CTS input on the computer's RS232
connector (Table 13) 

CTS

Transmit starts when an XON character (^Q) is received
from the CNC.

XON

Transmit starts when the operator clicks the "Start Now"
button on the Communication application's main form. 

Manual

Transmit starts immediately. The CNC must be ready to
receive data when the Dostek DNC Transmit command is
executed.

None

Most CNCs output an XON character when ready to receive if configured for
"XON/XOFF" or "DC-Code" flow control. If your CNC outputs a different character, select
"Other" and specify the character by entering a numeric value or symbol (for example,
enter "^R" or "18" if your CNC outputs the 'DC2' code).

Some CNCs do not output a character when ready to receive, but do turn on one or
more of it's RS-232 control signals. In this case, connect the appropriate CNC RS-232
output signal to the "CTS" input on the computer’s RS-232 port and select the "CTS"
Transmit Trigger option.

If the receiving device is always ready to receive data, choose "None". 

If the receiving device does not provide a suitable trigger when ready to receive (charac-
ter or RS-232 signal), set the transmit trigger to Manual and start the transfer manually
by clicking the "Start Now" button on the Communication application's main form.

When the Dostek DNC Communication application is waiting for a trigger, you can start
the transfer manually by clicking the "Start Now" button.
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4.4.2 Transmit Repeat

If you drip-feed programs to the CNC and wish to run multiple parts, you can configure
Dostek DNC to automatically repeat (retransmit) a file by choosing one of the following
Transmit Repeat options:

Automatically retransmit the file without pausing.Continuous

Automatically retransmit the file, but wait for the specified
Transmit Trigger condition to occur again (4.4.1).

Triggered

Transmit the file once only.None

You can manually retransmit a file by clicking "Restart" on the Communication applica-
tion's main form.

4.4.3 Operator Instructions

Text entered in the Operator Instructions text box is displayed as a pop-up note each
time Dostek DNC is ready to start transmitting data. The note disappears when the trans-
fer begins. If you do not enter any text, a note is not displayed. You can disable display
of operator instruction notes by unchecking the “Show Instructions” item on the Commu-
nication application's View menu.

4.5 Receive Options

Choose the Receive Options tab to configure options related to receiving of files from
the CNC.

4.5.1 Receive Trigger

Use the Receive Trigger option to automatically transmit a trigger character to the CNC
when Dostek DNC is ready to receive. Choose one of the following options:

Transmit the specified character when ready to receive.Other

Transmit an XON character (^Q) when ready to receive.XON

Do not send a trigger character to the CNC.None

If you normally prepare the computer to receive before using the Punch command on
the CNC, set Receive Trigger to "None".

Some CNCs and tape readers do not respond to any trigger character, and can only be
triggered by turning on one of it's RS-232 input signals. In this case, connect the device's
trigger input signal to the "DTR" output signal on the computer's RS-232 port. Dostek
DNC turns the "DTR" signal on when ready to receive and turns it off when receive is
terminated (regardless of the Receive Trigger setting).
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Specify a file extension to add to automatic file names. If the
detected name already contains a file extension, this setting is
ignored. If Extension is blank, the default file extension specified
on the Global, Communication Options tab will apply.

Extension

Specify a character or string to insert at the start (Prefix) or end
(Suffix) of the program name. Use Prefix or Suffix to add an
"upload" identifier or "machine" identifier to automatic file names.
For example, machine identifier "M3" could be added as
“M3-O1234.TAP” (prefix) or “O1234-M3.TAP” (suffix).
If a Master Name Prefix (Table 5) is also specified, the file is
named Master Prefix + Device Prefix + name + Extension.

Prefix, Suffix

DescriptionItem

Name Format Group

Specify either (a) a numeric value indicating the maximum length
of the program name, or (b) the letter or symbol that appears
immediately after the program name. If End is blank, the program
name ends at the end of the line.

End

Specify either (a) a numeric value indicating the column in which
the program name starts, or (b) the letter or symbol that appears
immediately before the program name. If Start is blank, the
program name starts at the beginning of the line.

Start

Specify the line containing the program number with respect to the
Identifier. In most cases, this option is set to Same Line. However,
some CNCs output the program name on the line following the
Identifier.

Line

Specify the character or string that the CNC outputs at the
beginning of a line to identify the start of program number data.
For example, the Identifier is either “O” or “:” for most Fanuc
CNCs.

Identifier

DescriptionItem

Name Location Group

Table 12 - Automatic File Naming
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4.5.2 Receive Terminate

Dostek DNC terminates receive mode according to the which of the following Receive
Terminate options is selected:

Receiving is terminated when the specified time interval
(in seconds) elapses with no data received. Timing of the
interval does not begin until the first data is received.

Time

Receiving is terminated when the specified string of
characters is received. (For example, "M30" or "#END#").

String

Receiving is terminated when the specified character is
received. (For example, "%" or "^D"). 

Character

Receiving is terminated when you click the "Stop" button.Manual

If the computer is turned off (or the power fails) before receive is terminated,
some received data may be lost.

4.5.3 Operator Instructions

Text entered in the Operator Instructions text box is displayed as a pop-up note each
time Dostek DNC is ready to start receiving data. The note disappears when the transfer
begins. If you do not enter any text, a note is not displayed. You can disable display of
operator instruction notes by unchecking the “Show Instructions” item on the Communi-
cation application's View menu.

4.6 Receive File Naming

The Automatic File Naming option group (Table 12) specifies options for automatically
naming files received from the CNC. Received files can be named according to the
CNC's program identifier or according to other information (such as part number) stored
in a comment on the first line or two of the program. This option group is disabled if the
"Default Receive File Naming Mode" on the global "Communication Options" tab is set
to Manual (Section 3.4.2).

Automatic naming options specify the location of the file name and can add an optional
prefix, suffix or file extension.  Consider the following example of the first line of a
typical CNC program:

    O1234 (75X438-22-001 UPPER CONTROL BRACKET)

Automatic naming options can be configured to name the file according to any of the
following examples:

v the CNC's program number ("O1234")
v the entire first line of the program, plus a file extension
v the entire text enclosed in parenthesis, plus a "#" suffix to indicate an uploaded

file (the suffix ensures the received file does not have the same name as the
original file, so the original file will not be replaced or recycled)

v the text enclosed in parenthesis up to the first space ("75X438-22-001")

Automatic naming of received files eliminates file name errors caused by typing
mistakes and can prevent overwriting of original program files (by using the Prefix,
Suffix or Extension option).
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For more information about naming, replacing and recycling of received files, refer to
Section 5.3 in the Dostek DNC User Guide.

4.6.1 File Naming Examples

The following examples illustrate how to apply the receive file naming options described
in Table 12.

Example 1 - O1234

The program identification is a four-digit number on a line starting with the character "O".
To store the file as "O1234", set the file naming parameters as follows:

Identifier O (letter O)
Line Same line
Start 1
End/Length 5

Example 2 - :1234

The program identification is a four-digit number similar to example 1, except the line
starts with the colon character (":"). Because the colon character is not permitted in a
Windows file name, the Column parameter must be set to 2 and the length to 4. The
Prefix option can be set to “O” (letter O) to store the file as "O1234".

Identifier :
Line Same line
Start 2 (colon character : also works)
End/Length 4
Prefix O (letter O)

Example 3 - Machine ID Prefix

To change Example 1 so that machine identification prefix “M3” is inserted before the
program number to create a file named "M3-1234", set the file naming parameters as
follows:

Identifier O (letter O)
Line Same line
Start 2 (O (letter O) also works)
End/Length 4
Prefix M3-
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Example 4 - (PGM,="ABC123           ")

The program name is enclosed in quotes on a line starting with "(PGM". To store the file
as “ABC123”, set the file naming parameters as follows:

Identifier (PGM
Line Same line
Start 8 or "
End/Length 20 or "

Set the name length option to either the double quote character (") or maximum number
of characters possible in the file name. Dostek DNC trims leading and trailing spaces
from the file name to comply with Windows file name rules.

Example 5 - Program Number as Comment

If the program identification is stored as a comment on the same line as the program
number, such as:

O1234 (6A1234R XL-7 SHAFT)

set the file naming parameters as follows to name the file according to the text enclosed
within parenthesis:

Identifier O (letter O)
Line Same line
Start (
End/Length )

Example 6 - File Extension

If the program identification output by the CNC includes a file extension:

$A123456.MIN

set the End/Length option as follows to include or exclude the file extension:

End/Length . (period) file extension is excluded
End/Length 99 file extension is included

If the detected file name does not include a file extension, Dostek DNC automatically
uses the file extension specified by the "Extension" option in the Name Format option
group (Table 12) or, if blank, by the "Default file extension" option on the global
"Communication Options" tab.

Example 7 - Identifier and Name on Different Lines

If the program name is on the line following the identifier:

%PM
1234

set the file naming parameters as follows:

Identifier %PM
Line Next line
Start 1

Configuration Guide  Page 27

 



4.7 Managing Device Configuration Files

When the Dostek DNC Configuration program is started, all device configuration files in
the Settings folder are opened.

A specific file can be selected by picking it from the drop-
down list on the toolbar or by clicking the arrow buttons
adjacent to the list box.

Modifications are not stored in the configuration file until you choose to save them. If you
change your mind, you can exit DConfig without saving changes. Whenever changes
are made, the diskette icon on the toolbar is enabled. Save
changes by clicking the Save icon or by choosing “Save” from
the File menu. Save changes to all open files by clicking the
Save All icon on the toolbar or by choosing “Save All” from the File menu.

To create, rename, duplicate or erase a device configuration file:

Select “Choose Configuration Folder” from the File menu
to view or edit configuration files stored in a different
folder. Configuration file collections for multiple computers
can be stored in separate folders on a diskette or network
file server (Section 3.6).

Change Folder

Save or load backup copies of device configuration files
using the Configuration Manager (Section 3.6).

Backups

Choose "Samples" from the DConfig "Tools" menu to
copy selected sample configuration files to your Settings
folder. DConfig searches for sample files in folder
"Samples" on your hard drive or the Dostek DNC
CD-ROM.

Samples

Choose “Rename” from the File menu and specify a new
file name.

Rename

Choose “Delete” from the File menu or click the Delete
icon on the toolbar.

Delete

Choose “Save as” from the File menu and specify a name
for the new file.

Duplicate

Choose ”New Configuration” from the File menu or click
the New icon on the toolbar.

Create new file

4.7.1 Import

If you upgraded to Dostek DNC from either Dostek NC File Manager or Dostek DNC for
DOS (DDNC), you can import your existing device configuration files by choosing
"Import" on the File menu. Choose the type of file to import from the “Files of type” list,
then browse and select one or more files to import. A new Dostek DNC device configura-
tion file is created for each imported file. Because of software differences and new
features, settings that do not import directly are set to default values. In some cases, it
may be necessary to manually adjust imported configuration files.    

Page 28 Dostek DNC



5 Device Wiring and Testing

This section explains how to connect devices to the computer's RS-232 ports, and how
to test communication between the computer and devices.

5.1 Connect Devices

A functional description of the RS-232 signals used by a standard PC-compatible
communication port is provided in Table 14. Cable wiring diagrams for common CNC
communication applications are illustrated in Figure 4.

Connect devices using a good quality multiple-conductor shielded cable. Use
low-capacitance cable for longer distances or high baud rates. Avoid running communi-
cation cables in proximity to electrical power circuits. Check with local authorities to
determine if your wiring is subject to electrical or building code regulations.

Data Terminal Ready output. When DSR/DTR flow
control is selected, Dostek DNC turns DTR on when
ready to receive data, and off when not ready. When
DSR/DTR flow control is not selected, Dostek DNC
turns DTR on while the communication port is open.

DTR420

Carrier Detect input. Not normally used. When the
Dostek 208/216 CommSwitch is used, CD is used to
monitor the CommSwitch.

CD18

Ground57

Data Set Ready input. When DSR/DTR flow control is
selected, Dostek DNC transmits data while DSR is on,
and suspends data transmission while DSR is off.

DSR 66

Clear To Send input. When CTS/RTS flow control is
selected, Dostek DNC transmits data while CTS is on,
and suspends data transmission while CTS is off.

CTS85

Request To Send output. When CTS/RTS flow control
is selected, Dostek DNC turns RTS on when ready to
receive data, and off when not ready. When CTS/RTS
flow control is not selected, Dostek DNC turns RTS on
while the communication port is open. When the Dostek
208/216 CommSwitch is used, RTS is used to control
the CommSwitch.

RTS74

Receive Data input to computer from device.RD23

Transmit Data output from computer to device.TD32

FunctionSymbolDE9DB25

Table 13 - RS-232 Communication Port
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Figure 4 - Common Cable Types for CNC Applications

vmaximum cable length allowed by RS-232 specification is 50 feet; however,
cables up to 250 feet are commonly used

vuse good quality multiple-conductor cable with 24 gauge (or 22 gauge)
stranded conductors and an overall foil shield; choose cable with a 'low
capacitance' rating for longer distances or high baud rates

vavoid placing communication cables in proximity to electrical power circuits

vavoid stretching or sharply bending the cable

Cable Installation Guidelines
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5.2 Testing Communication 

Testing communication between the computer and CNC involves four steps:

Section 5.2.4q test transmit (from computer to CNC) . . . . . . . . .

Section 5.2.3q test receive (from CNC to computer) . . . . . . . . . .

Section 5.2.2q test cable . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 5.2.1q test computer's communication port . . . . . . . . . .

To save time, test the communication port and cable only if you are unable to transmit or
receive.

Considerable startup time can be saved by following the simple test procedure provided
in Section 5.2. Always test communication by first punching a program from the CNC to
the computer because, if the communication settings are incorrect, Dostek DNC usually
displays received data while the CNC usually does not, and Dostek DNC usually displays
more informative error information than the those displayed by the CNC.

Note: Select 2 stop bits until communication with the device is working properly, and
then try selecting 1 stop bit if faster data transfer is important.

Using DConfig

When using the Dostek DNC Configuration program to create and modify device
configuration settings (Section 4), remember:

v changes you make are not saved in the device configuration file until you exit
DConfig or use the Save command

v the Communication application (DDNC32) reads the device configuration file
when you start the program or when you use the "Reload" command

If DDNC32 is running when you change a communication setting using DConfig, update
DDNC32 with the new settings by using the DConfig "Save" command then the DDNC32
"Reload" command.

Tools Required

An "RS-232 Breakout Box" or an "RS-232 Mini Tester" is recommended if detailed
testing is required. This device plugs into an RS-232 connector and provides LED indica-
tors to display the state of the RS-232 signals. RS-232 testers can be purchased from
computer and electronic stores, or from Dostek. This manual assumes the tester indica-
tor is red when the RS-232 signal is on, green when the signal is off, and off when the
signal is disconnected.

If the RS-232 port on either the CNC or computer uses a 9-pin connector, a 9-25 adapter
and a 25-9 adapter may also be required.

A "loop-back" adapter is required for some tests. You can build a loop-back adapter by
wiring together pins 2 and 3 of a DB25S or a DB25P connector.

The Dostek DNC Terminal program (DTerm32) is required for some tests. To start
DTerm32, choose "Terminal" from the DConfig "Tools" menu or from the File Manager
"Supervisor" menu. 

Configuration Guide  Page 31

 



5.2.1 Test Communication Ports

To test the computer's communication port:

1. Plug the RS-232 tester into the computer's RS-232 connector (leave the
CNC cable unplugged). The "TD" indicator (pin 2) should be green, and the
"RD" indicator (pin 3) should be off. If either indicator is red, the computer
communication port may be defective.

2. Start DTerm32, and configure as follows:
vclear the "Display typed characters" check box ("Display" options)
vset the baud rate to 300
vset the COM port to select the RS-232 port the tester is plugged into

3. Plug a loop-back adapter into the tester and type some characters on the
computer keyboard. Both the "TD" and "RD" indicators on the tester should
flash red each time a key is pressed, and each typed character should
appear on the DTerm32 screen. If the typed characters are not displayed
and the tester indicators do not flash, the wrong COM port may be selected
or the communication port may be defective. If the tester indicators both
flash but typed characters are not displayed, the communication port input
may be defective. Try using a different COM port.

To test the CNC's RS-232 output port:

1. Test the cable according to the procedure in section 5.2.2.

2. Connect the cable between the computer and CNC.

3. Start DTerm32, and configure as follows:
vset the baud rate to match the CNC
vset the COM port to select the RS-232 port to which the CNC is connected
vsend a program from the CNC to the computer

4. If data is displayed on the computer screen, the CNC's RS-232 output port
is likely working properly. If the displayed data is incorrect, the CNC and
computer parameters may not match (baud rate, parity, ISO/EIA, etc.). If
no data is displayed and the CNC appears to indicate that output is
complete, the CNC's RS-232 output port may be defective. If the CNC
displays an alarm, the cable may not be wired properly, the cable may be
connected to the wrong port on the CNC, or the CNC parameters may be
set incorrectly.

To test the CNC's RS-232 input port:

1. Test the cable according to the procedure in section 5.2.2.

2. Connect the cable between the computer and CNC.

3. Start DTerm32, and configure as follows:
vset the baud rate to a setting that is different than the CNC (for example, if the

CNC is set to 4800 baud, set DTerm32 to 2400 baud)
vset the COM port to select the RS-232 port to which the CNC is connected
vprepare the CNC to receive data (press READ, LOAD, etc.)
v type several different characters on the computer keyboard

4. If the CNC displays an alarm indicating a communication data error (parity
or framing error, for example), the CNC's RS-232 input port is likely
working properly. If no alarm is displayed, and the CNC appears to
continue waiting for data, the CNC's RS-232 input port may be defective.
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5.2.2 Test Cable

To test the cable connecting the computer to the CNC:

1. Plug one end of the cable into the CNC communication port and plug the
RS-232 tester into the computer end of the CNC cable (do not plug the
computer end of the cable into the computer yet). The "RD" indicator (pin
3) on the tester should be green, and the "TD" indicator (pin 2) should be
off. If either indicator is red, the CNC communication port may be
defective. If the "RD" indicator is off and the "TD" indicator is green,
connections to pins 2 and 3 in the cable may be reversed.

2. Plug the tester into the computer's RS-232 port, plug the computer end of
the CNC cable into the tester, and plug the CNC end of the cable into the
CNC communication port. Both the "TD" and "RD" indicators should be
green. If either indicator is off, connections to pins 2 and 3 in the cable
may be reversed.

3. Repeat the communication port test (Section 5.2.1) except plug the CNC
cable into the computer and plug the loop-back adapter into the CNC end
of the cable. If the typed characters are not displayed and the tester TD
and RD indicators do not flash, the wrong COM port may be selected or
the communication port may be defective. If the tester's TD and RD
indicators both flash but typed characters are not displayed, the cable may
be defective.
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5.2.3 Test Receive

To test receiving of data from the CNC to the computer:

1. Plug the RS-232 tester into the computer's RS-232 port and connect the
cable between the CNC and the computer.

2. Start DTerm32, and configure as follows:
vselect the COM port the RS-232 tester is plugged into

vset the "Port Settings" parameters to match the CNC communication settings
(for most CNCs, even parity, 7 data bits, 2 stop bits, XON/XOFF flow control and
ISO data format are suitable)

v "check" the "Display typed characters" check box ("Display" options)

v "uncheck" the "Display control characters..." check box ("Display" options)

v "check" "COM Port Open" on the "Options" menu

3. Transmit (Punch) a program from the CNC to the computer.

4. If the program is displayed properly on the computer screen, proceed to
"Test Handshaking" below.

5. If the program is displayed, but some or all of the data is garbled, distorted
or otherwise incorrect, proceed to "Data Format" below.

6. If the CNC displays an alarm indicating the RS-232 "timed out" or is "not
ready", or the CNC appears to be waiting indefinitely, proceed to "Test
Handshaking" below.

7. If the CNC transmits data (either TD or RD indicator on tester is flashing
red), but no data is received at the computer, check the computer's
communication port (Section 5.2.1) and the cable (Section 5.2.2). If the
cable is wired properly, the tester's RD indicator should flash red when
data is being received at the computer.

Test Handshaking

Most CNCs will not transmit data until specific RS-232 signals are turned on (as
indicated by red on most RS-232 testers). Some CNCs also require the computer to
send a specific "trigger character" when ready to receive data.

If the computer and CNC are both set for "XON/XOFF" or "DC Codes" flow control, the
cable shown in Figure 4 (a) will normally work. In most cases, all tester indicators will be
green when the CNC is not ready to communicate, and the RTS, CTS, DSR, CD and
DTR indicators will all be red when the CNC is attempting to communicate. If the RTS or
DSR indicators remain green, or the CNC issues an alarm or waits indefinitely, consider
the following:

q The cable may be connected to the wrong connector on the CNC.

q The CNC may be configured to punch to the wrong port or device.

q The CNC may require a cable wired for "hardware handshaking" (Figure 4 (c)).

q The CNC may require the computer to send a "trigger" character to start the
transfer — try setting the Receive Trigger to Xon or "^R".

q The CNC communication port may be defective.

q Refer to the CNC manufacturer's documentation for more information about
RS-232 communication protocols.
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Check Data Format

If the received data is not correct, consider the following:

q If received data is garbled (distorted), check that the CNC's communication
parameters match the computer's settings, or determine the correct settings
experimentally by changing the DTerm32 communication settings (baud rate,
data bits, parity, etc.). Most CNCs use ISO data format, which is 7 data bits
and even parity, although some require the CNC be set to 8 data bits with no
parity and the computer set to 7 data bits with even parity.

q Try switching DTerm32 between ISO, ASCII and EIA data format.

q If only about half the characters are displayed properly in ISO or ASCII mode,
the baud rate is correct but the parity or data bit setting may be incorrect.

q Try setting DTerm32 to use 8 data bits and even parity, and check the "Display
as 7-bit character" check box ("Display" options).

q Try using 2 stop bits until receive works properly, then switch back to 1 stop bit
if faster throughput is important.

Configure Receive File Naming

Once a program can be received from the CNC and display properly on the DTerm32
screen, configure and test the Automatic Naming of Received Files feature as follows:

1. Transmit a program from the CNC to the computer and capture the data in
a log file using DTerm32 (Section 5.3.2).

2. Transmit a program from the CNC to the computer. Close the log file when
the transfer is complete.

3. View the log file (using File Manager) to analyze the format of the received
data and set the receive naming options as explained in Section 4.6.

4. Test receive file naming by transmitting several programs from the CNC to
the computer (User Guide, Section 5.3). Each received file should be
stored in a separate file named according to the option settings you chose.

5.2.4 Test Transmit

Transmit a file from the computer to the CNC (User Guide, Section 5.2). If the program
is received correctly at the CNC, proceed to "Transmit AutoStart" below. If the program
is not received correctly at the CNC, consider the following:

q If the CNC displays an alarm indicating a communication "overrun" or
"overflow" error (a common problem with Fanuc 10 and Fanuc 11), set the
communication port transmit FIFO to use a smaller size (refer to Section 5.2.6
"FIFO Buffers").

q If the first line of the program is missing or the CNC displays an alarm
indicating the program number is not valid, set Transmit Initialize to "^J".

q Some CNCs require the program number to start with a colon character ":"
instead of an "O" when using ISO or ASCII data format.

q If the CNC displays an alarm indicating a framing, overrun or similar error,
double-check the baud rate setting, set Stop Bits to 2 (Section 4.2) or
experiment with different parity or data bit settings.
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q If the CNC appears to read the program but waits indefinitely or displays an
alarm when the end of the program is reached, the CNC may be expecting a
particular character sequence to indicate the end of the program. Try setting  
Transmit Close to "^J%". If this does not correct the problem, capture CNC
output into a log file (Section 5.3.2) and analyze the format of the received
program to determine if any special characters are required after the program.
For example, if the CNC outputs "^T" or "^D" after the end of the program, set  
Transmit Close to match. 

q If the CNC always displays an alarm when receiving data, check
communication settings on both the CNC and computer, and review the CNC
manufacturer's documentation. Experiment with different data bit and parity
settings. Some controls, especially older models, are incapable of receiving
data at higher baud rates and may display a misleading alarm message. To
eliminate problems caused by higher baud rates, test communication at the
slowest possible baud rate (for example, 300 baud). If communication is
successful at a low baud rate, test with successively higher baud rates to
determine the highest reliable rate. 

q If the CNC always displays an alarm when receiving data, it may be necessary
to slow the data rate in order to determine exactly which character or section of
data is causing the alarm. For a controllable data rate, use DTerm32 and type
characters on the computer keyboard. To test a Fanuc CNC, for example, type
Ctrl+J, O (letter O), 1, Ctrl+J. The CNC should update the screen to indicate
that it is receiving program O0001. Continue by typing M, 3, 0, Ctrl+J, %. The
CNC should terminate receive mode and program O0001 should contain the
single line "M30".

q If the CNC does not display any alarm and does not appear to receive any
data, try to force an alarm condition by changing the computer's baud rate
setting. If using a different baud rate does not cause the CNC to report an
alarm, the CNC's RS-232 port may not be configured properly, may not be
connected properly (internally), or may be defective.

q If one or two characters are missing from the beginning of each line, try a lower
baud rate or an inter-block delay (Section 4.3).

q If sections of the program are missing (several characters or lines are missing),
the data flow control may not be working properly. Refer to "Test Flow Control"
below.

q If the computer does not automatically start sending data when the CNC is
ready to receive, refer to "Transmit Trigger" below.

q If extra blank lines appear in the received data, change the Transmit "End of
Block" setting. (Section 4.3)

q If blank lines that should appear are missing, clear the "Remove blank lines"
check box (Section 4.3).

q The CNC may display an ambiguous alarm message if the received program
contains a syntax or format error. To eliminate the possibility of a syntax or
format error, try sending a program from the CNC to the computer first, and
then send it back to the CNC. Edit the received file to change the program
number so it can be loaded in the CNC without conflicting with the original
program number.
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Transmit Trigger

If the computer does not automatically start sending data when the CNC is ready to
receive (that is, when the READ command is executed on the CNC), test the Transmit
Trigger feature as follows:

1. Start DTerm32, and configure as follows:
vselect the COM port the CNC is plugged into
vset the "Port Settings" parameters to match the CNC communication settings
vset Flow Control to "None"
v "check" the "Display control characters..." check box ("Display" options)
v "check" "COM Port Open" on the "Options" menu

2. Execute a READ command on the CNC, and observe the DTerm32
display. Any trigger characters output by the CNC will be displayed on the
screen. The trigger character is usually the XON character, which appears
as "^Q"). Set Transmit Trigger (Section 4.4.1) to match the CNC trigger
character.

3. If the CNC does not appear to output a trigger character, use the RS-232
tester to determine if the CNC turns one of the RS-232 signals from off to
on when it executes a READ command. If so, set Transmit Trigger to
"CTS" and connect the CNC output signal the CTS input on the computer
(Table 13).

If the CNC does not output a suitable trigger character or RS-232 handshake signal, set
Transmit Trigger to Manual.

Test Flow Control

After testing transmit and receive modes, verify proper flow control (handshaking) opera-
tion for transfers in both directions as follows:

1. Send the largest available program from the CNC to the computer, and
use Manual naming mode to store it in a file named TEST1.

2. Edit TEST1 to change the program number to an unused number.

3. Send TEST1 to the CNC (it will be stored under the new number).

4. Send the new program from the CNC to the computer and store it as file
TEST2.

5. Compare files TEST1 and TEST2 using the Editor's Compare command. If
the files are identical, communication and flow control are working properly
in both directions.

The first two steps of this test may appear unnecessary. The reason for starting by
sending a program from the CNC to the computer is that many CNCs automatically
reformat programs by removing spaces or blank lines, or even by renumbering blocks.
The file comparison in step 5 is accurate only if both files are formatted exactly the
same. 

Flow control operation should be re-tested any time a communication problem is
suspected or any time a significant change is made (faster baud rate, new cable, differ-
ent computer, etc.).
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5.2.5 High-Speed Communication

Dostek DNC supports high-speed communication with baud rates of up to 38,400 baud.
For reliable operation and maximum throughput, follow these recommendations:

q use a Pentium 120 or faster computer

q use a high-quality low-capacitance shielded computer communication cable,
and locate the computer as close to the machine tool as possible to reduce the
cable length (the cable should not exceed 50 feet in length)

q set the communication port FIFO buffers to maximum size (refer to "FIFO
Buffers", below).

q ensure parity is enabled; ISO/ASCII data format with even parity is
recommended

q work from a local hard drive — accessing a diskette or network drive to send or
store data may limit the data throughput

q close all other applications

q if a screen saver is required, choose "Blank screen"; some screen savers use
considerable computer resources and may interfere with high-speed
communication

5.2.6 FIFO Buffers

The computer's communication port is equipped with First-In-First-Out (FIFO) buffers to
enhance performance of data communication. For most applications, set the Transmit
Buffer to the highest value (16) and set the Receive Buffer to 8.

Some CNC machines may report a communication "overrun" or "overflow" error when
receiving information from the computer. This error can result if the CNC uses an input
buffer that is unable to accept up to 16 characters (the maximum size of the Transmit
buffer) after data flow is suspended. For example, some Fanuc CNCs (Models 10 and 11
in particular) can accept only 10 characters after suspending data flow. To correct the
problem, set the Transmit FIFO buffer setting to the Low (1) setting. Leave the Receive
FIFO setting at 8.

If Dostek DNC reports an "overrun" error when receiving from the CNC (to the
computer), set the Receive FIFO setting to a lower value. 

To set the communication port FIFO buffer in Windows 95 and Windows 98, use the
following command sequence: Start, Settings, Control Panel, System, Device Manager,
Ports, select a COM port, Properties, Port Settings, Advanced. After making this change,
restart (reboot) the computer.

To set the communication port FIFO buffer in Windows NT 4, use the command
sequence: Start, Settings, Control Panel, Ports, select a COM port, Settings, Advanced.
After making this change, restart (reboot) the computer.
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Figure 5 - DTerm32 - Dostek DNC Terminal

5.3 Terminal Program - DTerm32

The Dostek DNC Terminal Program is used for interactive testing and troubleshooting of
RS-232 communication. DTerm32 transmits characters you type on the computer
keyboard and displays received data on the screen. You can also capture received data
to a log file or transmit a text file. ASCII, ISO and EIA-244 data formats are supported.

Start DTerm32 by choosing "Terminal" from the File Manager "Supervisor" menu or the
DConfig "Tools" menu, or by choosing "Dostek DNC Terminal" from the Start menu.

Received data and typed characters are displayed in a scrollable text window. Data that
has scrolled off the screen can be viewed using the scroll bar or by pressing Page Up,
Page Down, Ctrl+Home or Ctrl+End. The last 8000 characters (approximately) are
stored in the scroll-back buffer.

RS-232 control signal states are displayed on the right side of the toolbar. Red indicates
the signal is on, and green indicates the signal if off. The computer's RTS and DTR
output signals can be turned on or off by clicking the indicator on the tool bar. Communi-
cation settings and status is displayed on the status bar at the bottom of the form.

5.3.1 Configuration

After starting DTerm32, select a communication port and configure port settings (baud
rate, etc.) by choosing "Settings" from the Options menu, or by clicking the "Change
settings" icon on the toolbar. To set DTerm32 according to a Device Configuration File,
choose a file from the list box on the Options "General" tab.

Initial settings are loaded from the  Dostek DNC system configuration file. Click the
"Save" button to replace the initial settings with the current settings, or click the "Reset"
button to reload the initial settings.
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Display Options

Choose the Options "Display" tab to set the following display options:

When checked, a split window is used to display data as
both text and as hexadecimal values.

Hexadecimal

When checked, all characters are displayed as 7-bit
characters. Use this option, for example, when DTerm32
is set for 8 data bits and received data may contain parity
information in the eighth bit. 

7-bit characters

When checked, control characters are displayed as
two-character symbols (eg: ^J for line feed). A list of
control character symbols is provided in Appendix A.

Note: DTerm32 does not display received XON and XOFF
characters (^Q and ^S, respectively) on the screen while
flow control is set to XON/XOFF. To view these control
characters, set flow control to NONE.

Controls
characters as

symbols

When checked, typed characters are displayed on the
screen. 

Typed characters

5.3.2 Capturing Data

Received data can be captured into a disk file. When used with the "Display control
characters as symbols" display option, this feature lets you analyze a CNC's program
format to determine correct communication option settings.

To capture received data: 

1. If necessary, "check" the DTerm32 "Display control char. as symbol" check
box ("Display" options).

2. "Check" "Capture to log file" in the DTerm32 "File" menu and type in a
suitable file name (for example, "TEST.LOG").

3. When finished capturing data, clear the check mark from "Capture to log
file" in the File menu.

5.3.3 Transmitting a File

To transmit a text file, choose "Transmit text file" from the File menu or click the "Trans-
mit" icon in the tool bar.
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6 MultiPort DNC

To prepare the Dostek DNC MulitPort Edition software add-on for use, follow these
steps:

Section 3.6q make backup copies of configuration files . . . . . . . . . . . . . .

Section 6.3.2q add machines to MultiPort DNC server . . . . . . . . . . . . . . . .

Section 6.3.1q configure MultiPort DNC server . . . . . . . . . . . . . . . . . . . . .

Section 4.8q configure remote request parameters . . . . . . . . . . . . . . . . .

Section 6.1 q configure file transfer protocol . . . . . . . . . . . . . . . . . . . . . .

Checklist
Page 1

q install, configure and test Dostek DNC Professional Edition
software according to checklist provided on page 1 . . . . . . .

The Dostek MultiPort DNC Server application receives allows the CNC user to upload,
download and drip-feed files directly from their CNC console. To send a command from
the CNC to Dostek MultiPort DNC, the CNC operator creates and outputs (punches) a
small CNC program that is formatted in a specific way. The CNC operator can save a
CNC program to the computer or request a CNC program be sent from the computer to
the CNC. In addition, the operator can request a file directory or activity log report be
sent from the computer to the CNC.

When data is received from the CNC, Dostek MultiPort DNC aborts any transfers that
may already be in progress and stores received data in a file according to the receive file
naming parameters (Section 6.1.1). If the received file is recognized as a command file
(Section 4.8.4), the command is interpreted and acted upon. Otherwise, the file is simply
stored to disk. 

To save a program to a disk file, the operator simply sends it to the computer. To store
multiple programs into a single disk file or to store a program as a specific file name, the
operator must send a Receive Open command file, output the program(s), and send a
Receive Close command file.

When the CNC operator requests the computer send information to the CNC (a program
file or a report), the computer prepares the file sends it to the CNC when the CNC opera-
tor executes a "read" or "input" command, or a time out occurs.

Recommendations

When preparing device configuration files for use with Dostek DNC MultiPort Server,
consider the following recommendations:

q create and configure devices according to the checklist provided in Table 7
(page 20)

q connect devices to the computer according to Section 5.1

q test communication between the computer and CNCs using the Dostek DNC
Professional Edition components according to the checklist provided at the
start of Section 5.2; in particular, test receive file naming, receive terminate
and transmit trigger features
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6.1 Protocol Configuration

The Dostek DNC command format and file transfer protocol may be easily configured for
each individual machine to accommodate virtually any type of CNC. Protocol settings
control how the Dostek DNC software determines when a file has been received, when a
received file is a command file (rather than a CNC program file) and when the CNC is
ready to receive a requested file.

6.1.1 Receive File Naming

The Receive File Naming parameters (Section 4.6) must be suitably configured for
Dostek MultiPort DNC to work properly. 

Most CNCs output a program number in the first line when sending a program to the
computer. For example, most Fanuc CNCs output the letter "O" followed by a 4-digit
program number. When using a CNC that does not output a program number, you must
always format the first line of each program in a specific way before sending the
program to the computer. For example:

N0001X0.1234

In this case, set the receive file naming parameters (Section 4.6) as follows:
Identifier N0001
Start . (period)

When configured this way, Dostek DNC will save each received program in a file named
according to the numbers following the decimal point.

6.1.2 Receive Terminate

The Receive Terminate parameter (Section 4.5.2) must be suitably configured for
Dostek MultiPort DNC to properly detect the end of data received from the CNC.

Most newer CNCs send a "%" character or a "Control-T" character after sending a file to
the computer. When the Receive Terminate parameter is set to match the CNC, Dostek
DNC can process received files and commands immediately.

To determine how the CNC terminates output, read the CNC manual or capture data
using the Dostek DNC Terminal application (DTerm32, Section 5.3.2). 

If the CNC does not terminate output in a detectable way, set the Receive Terminate
mode to "Time" and set the time out value to 2 seconds. This way, Dostek DNC will
process each received file 2 seconds after the last data is received.

If the CNC outputs null characters (displayed as ^@ by DTerm32) after the end of the
program, set the CNC parameters to disable output null characters. If the CNC can not
be configured to omit null characters, then select the time out mode as explained in the
previous paragraph.

6.1.3 Transmit Trigger

The Transmit Trigger parameter (Section 4.4.1) must be suitably configured for Dostek
MultiPort DNC to properly wait until the CNC is ready to receive requested data from the
computer.

Most newer CNCs send a "Control-Q" character (XON) to the computer as soon as the
operator executes the "read" or "input" command. Others turn on one of the RS-232
control signals. 
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If the CNC provides no detectable indication of when it is ready to receive, set the
"Transmit Trigger Timeout" value (Section 4.8.5) to a value of, say, 5 seconds. This way,
Dostek MultiPort DNC server will automatically send the requested data about 5 seconds
after the command is received. Set the time out value to provide adequate time for the
CNC operator to press the necessary buttons to execute a "read" or "input" command.

If Receive Terminate mode is also set to "time out", the total time between when the
CNC finishes data output and the computer starts to send data will be the sum of both
time out settings. 

6.2 Remote Request

Choose the Remote Request tab (Dostek DNC Configuration application) to configure
options related to uploading and downloading of files using the Dostek DNC communica-
tion server module, DMDNC32 (MultiPort Edition).

In order to use remote request commands, the "Receive Terminate" (Section 4.5.2) and
"Automatic File Naming" (Section 4.6) options located on the Receive Options tab must
be enabled and configured properly.

6.2.1 Commands

Remote request commands may be customized for each CNC. The default settings are:

+T Transmit file from computer to CNC

+R Receive file from CNC to computer

+D Transmit file directory from computer to CNC

+M Transmit recent messages from computer to CNC

Any character or string of characters can be specified for each command in the
"Commands" frame on the Remote Request tab in DConfig. For example, the command
identifier for the Transmit command could be changed to "#SEND".

The "+" symbol is used at the beginning of each default command identifier to ensure
that comments are not incorrectly interpreted as commands. In the following command
file, for example, the comment starting with "(TYPE" is not incorrectly interpreted as a
Transmit command.

(+T,A123-456)
(TYPE PROGRAM NAME ABOVE AND PUNCH TO COMPUTER)

6.2.2 Message/Feedback File

The Message/Feedback option specifies the first line of the message or feedback file
that is transmitted from the computer to the CNC if an error occurs while processing a
remote request command or if the CNC operator uses the Message command to request
a list of recent MultiPort DNC messages.

Use this option to specify the program number and an optional comment. By default, the
Message/Feedback option is set to "O7999 (DNC MESSAGES)". This way, the message
file will always load as program number O7999, and the comment "DNC MESSAGES" will
usually appear in the CNC program directory.
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If the Message/Feedback option is blank, the message file sent to the CNC will not
contain a program number and the CNC will usually either store the file according to the
first available program number or ask the operator to enter a program number.

6.2.3 Command Format

Command format options specify how commands are to be formatted when sent from
the CNC to the computer.

Some common punctuation or symbol characters are not
permitted on certain CNCs. Up to 5 character substitutions
may be specified. Enter characters in pairs starting with
the character to be substituted and followed by the
character to substitute. Separate character pairs with a
space. For example, to substitute the forward slash for the
backward slash and the equal sign for the colon, enter:

\/ :=

Character
Substitution

Specify the character that command options must begin
with. The default is minus "-". For example:

(+T A123-456 -C)

Option

Specify the character or characters that each command
line must begin with and end with. The default settings are
to start with a left parenthesis "(" and end with a right
parenthesis ")". For example:

(+T A123-456)

Start, End
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6.2.4 Command Files

Dostek MultiPort DNC provides two options for recognizing remote request commands
received from the CNC:

v recognize a defined range of "Master Program Numbers" as remote request
commands

v search all small files for remote request commands

Either option or both options may be enabled. By default, only the "Scan all small files"
option is enabled because the program range specification varies according to the type
of CNC.

Where possible, Dostek recommends selecting only the "Master Program Numbers"
option and specifying "O799*", ":799*" or "$799*" (depending on CNC) so the command
samples provided in the manual will work correctly.

Both options may be checked. If both options are
unchecked, remote request operation is disabled.

(Note)

When checked, all received files less than 500 characters
in size are searched for remote request commands.

Scan all small
files

When checked, program numbers matching the specified
number are permanently designated as remote request
command files. For example, if "O799" is specified and the
CNC uses a 4-digit program number, program numbers
O7990 through O7999 will always be treated as remote
request command files. 

The Master Command Programs option must be checked
in order to use the remote request Receive command
(User Guide, Section 6.2).

Master
Command
Programs

6.2.5 Options

One of two options is displayed, depending on whether the BTR440 protocol is selected
(when using a Dostek Model 440 Behind-the-Tape Reader).

A transmit command using the Dostek Model 440 BTR will
automatically reset (terminate) when the specified time
interval elapses. This feature prevents a failed transfer
from blocking received data from the CNC.
Recommended setting is 30 seconds.

BTR Transmit
Reset

Transmit will start automatically when the specified time
interval elapses, even if a trigger is not received from the
CNC. This feature allows remote request commands to
work even if the CNC does not issue any trigger when it is
ready to receive, and allows a transmit command to
complete even if the CNC issues the trigger before the
computer is ready to respond. Recommended setting is
between 10 and 20 seconds.

Transmit Trigger
Timeout

Configuration Guide  Page 45

 



6.3 Configure MultiPort DNC Server

This section explains how to add, remove and rearrange devices, configure device
settings and configure server options for the Dostek MultiPort DNC Communication
Server application (DMDNC32.EXE).

6.3.1 Server Options

Choose "Options" from the MultiPort DNC Communication
Server's "Configure" menu to configure server options.

Start Options

When the "Start as a Windows service" option is checked,
Dostek MultiPort DNC communication server starts working
as soon as Windows starts, and continues to work even
without a user logged on. When running as a Windows
service, the server icon appears in the Windows system
tray. To view or manage the server while it is running as a
service, log on to Windows and right-click or double-click
the server icon in the system tray.

After changing this option, you must restart Windows for the new setting to take effect.

Receive Options

Received files (uploaded from the CNC to the computer) will always replace existing
files of the same name. When the "Keep (rename) existing files" option is selected,
existing files of the same name will be erased (if located on a network drive) or sent to
the recycle bin (if located on a local fixed drive).

When the "Keep (rename) existing files" option is selected, existing files of the same
name will be renamed. The renamed files will include an 8-digit numeric suffix denoting
the date and time the replacement occurred. The suffix is formatted as "+DDDDDTTT" with
the first 5 numeric digits representing the date as the number of days since 1/1/1900,
and the time representing the number as a fraction of a day (500 representing 12 noon).

The "Keep..." option will prevent the accidental loss of files, but can result in a large
number of backup files being created. To purge the old backup files, use the file search
capability of the Dostek DNC File Manager to find all files matching "*+*" and matching
a date range. When the search result is displayed, confirm that the files are all old
versions that can be safely deleted, then choose the "Delete" button.

6.3.2 Adding and Managing Devices

Each active channel is represented by a separate row in the channel table on the Multi-
Port DNC server main form. When Dostek MultiPort DNC is started for the first time, the
channel table is empty.

To add a device to the table, choose "Add Device" from the Configure menu, or click the
Add Device button in the toolbar. When a device is added, it will remain inactive until all
device properties (Section 6.3) are properly configured. The maximum number of rows
in the table is determined by the software license. Choose "About" from the Help menu
to view the maximum number of ports for your system. If more ports are needed, contact
Dostek for a license upgrade.
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To remove a device from the table or move a channel up or down in the table, choose
the appropriate item from the Configure menu or click the appropriate button in the
toolbar. Devices may not be deleted or moved while they are connected.

Reset Device

To reset a device, choose "Reset" from the Configure menu. To reset all devices,
choose "Reset All" from the Configure menu. Resetting a device disconnects the
communication port, reloads the device configuration settings and reconnects the
communication port. 

Device Modes

Three channel modes are possible. The channel mode may be set by choosing from the
Device menu or by clicking one of three toolbar mode buttons. 

The channel is disconnected (not connected to a
communication port). 

Disconnected

The channel is waiting for or processing a remote request
command from the CNC. 

Remote Request

The channel is ready to accept manual Transmit or
Receive commands issued at the computer.

Manual

6.3.3 Device Properties

To configure properties for the currently-selected device, choose "Device Properties"
from the Configure menu or click the Device Properties button in the toolbar. The Device
Properties form provides two tabs. 

Choose the Device tab to view, change, remove or edit the device configuration file
associated with the channel.

Choose the Options tab to configure channel options including file locations.

Transmit Options

Transmit options specify the root folder for the channel as well as the default transmit
repeat mode for manually-transmitted files.

CNC operators will be allowed to obtain directory listings and to download files stored in
or below the transmit root folder, but will be denied access to files outside the transmit
root folder.

Receive Options

Receive options specify the location to store received files as well as the default receive
file naming mode for manually-received files.

Uploaded files always replace existing files of the same name. To prevent overwriting of
original files, specify a separate "Receive to" folder. For example, create an "Uploads"
folder in the Transmit Root folder. This way, the CNC operator will be able to download
either the original version in the transmit root folder or the modified version in the
Uploads folder.

Replaced files may be converted to backup files by specifying the "Keep" option (Section
6.1.2). If the "Keep" option is not enabled, replaced files will be moved to the Windows
recycle bin if they are located on a local fixed disk. 
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Remote Request Options

Check the "Search subfolders..." option to enable the MultiPort DNC communication
server to search one level of subfolders to locate a requested file. If this option is not
checked, only the Transmit Root folder will be searched (Section 6.3.1).

Check the "Start in Remote Request Mode" option to start the channel in Remote
Request mode. This option should normally be checked for all devices. If this option is
not checked, the channel will start in manual mode (Section 6.2, "Device Modes").
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Appendix A

Special Characters
The ASCII character set used by personal computers includes 32 special "control"
characters in addition to 96 printable letters, numbers and symbols. Dostek DNC/32
permits use of special characters in configuration fields by expressing them as a
two-character string comprised of the caret symbol (^) followed by a letter, as listed in the
following table. The decimal and hexadecimal values of each special character are listed.

The first item in the table (^@@) is a special symbol for use in transmit prefix and transmit
suffix fields to output a 5-inch leader (50 null characters). The leader symbol can be used
when transmitting to a tape punch or when transmitting to a CNC that issues an alarm if
the program is not "framed" by tape leader.

0F15SI^O

1F31US^_0E14SO^N

1E30RS^^0D13Carriage Return^M

1D29GS^]0C12Form Feed^L

1C28FS^\0B11Vertical Tab^K

1B27Escape^[0A10Line Feed^J

1A26SUB^Z99Horizontal Tab^I

1925EM^Y88Backspace^H

1824CAN^X77Bell^G

1723ETB^W66ACK^F

1622SYN^V55ENQ^E

1521NAK^U44EOT^D

1420DC4^T33ETX^C

1319DC3 (XOFF)^S22STX^B

1218DC2^R11SOH^A

1117DC2 (XON)^Q00Null^@

1016DC1^P50 Nulls^@@

HexDecDescriptionCharHexDecDescriptionChar
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Appendix B

Using Command Line Options

Optional command-line parameters such as file names or operating modes may be
specified when you start a Dostek DNC/32 application from any Windows shortcut (Start
Menu, Desktop, Send To Menu, etc.) or from an application program you write. For
example, you can use a command line "argument" when starting the Communication
application (DDNC32.EXE) to specify a file name and communication mode (transmit or
receive).

This Appendix describes the Dostek DNC/32 command-line options and explains how to
use the Dostek DNC/32 command line in Windows shortcuts and in your application
programs.

Section 3Programming Guide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 2Windows Shortcuts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Section 1Command Line Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1 Command-Line Options

This section describes the command-line arguments that can be used with each Dostek
DNC/32 application.

Command-line arguments may specify file names or command options. Command
options must be preceded by a forward slash character (for example: "/TRANSMIT") to
distinguish them from file names.

Arguments must usually be separated by spaces. For this reason, file names that contain
spaces must be enclosed in double quote characters (for example:
"C:\NC Tapes\O1234.TAP").

1.1 File Manager

One or more "Root Folder" names may be specified on the Dostek DNC/32 File Manager
application (DDFM32) command line. If multiple folder names are specified, they must
be separated by semicolon characters. For example:

DDFM32 C:\My CNC Programs;A:\

Because folder names are separated by semicolons, names that contain spaces need
not be enclosed in double quotes.

Root folders specified on the command line override root folder settings stored in the
configuration file (Section 4.1). However, if a root folder specified on the command line
is not a sub-folder of the root folders specified in the configuration file, and the "Manage
root folders" security option is checked, the user will be prompted to enter the supervisor
password. 



1.2 Communication

One or more file names and/or the following command line options are permitted on the
Dostek DNC/32 Communication (DDNC32) application command line:

/APS Enable "Automatic Protocol Selection" to automatically match the
device configuration file with the name of the current folder (Section
4.4.1)

/AutoName=x Specify a mode for automatic naming of received files (Section
4.4.2). Choices are:
      I - Individual
      S - Single
      M - Manual
If automatic file naming is disabled in the selected device
configuration file, this option is ignored.

/C=filename Specify a device configuration file. Wildcard (*) is permitted. Refer to
example below.

/J=filename Specify the name of a "job" file. A job file contains a list of one or
more files to be transmitted.

/NoBrowse When specified, the file "browser" may not be used to select a file (a
file name must be typed in).

/NoSetting When specified, the "Settings" item is removed from the File menu,
and the operator may not launch the Dostek DNC/32 Configuration
application from within the Communication application.

/Receive Receive mode.

/Transmit Transmit mode. Transmit mode is the default mode, and will be
activated unless /Receive or /? is specified.

/? Prompt user to select Transmit or Receive mode. Transmit mode is
the default mode, and will be activated unless /Receive or /? is
specified.

When Receive mode is used, one file name may be specified on the command line. If
no file names are specified, the user is prompted to select a file. If more than one file
name is specified, only the first name is used. Enclose a file name in double quotes if
the name includes spaces. For example:

   DDNC32 "3XR Pump housing.tap" /Receive

When Transmit mode is used, one or more file names may be specified on the
command line. If no file names are specified, the user is prompted to select one or more
files. If more than one file name is specified, each file is transmitted in sequence. To
specify multiple file names, separate the names with spaces. For example:

   DDNC32 O1234.TAP "3XR Pump housing.tap"

Multiple files may also be transmitted by specifying the name of a "job file". The job file
is a text file that contains the name of each file on a separate line. All files must be
located in the same folder as each other. To specify a job file, use the "/J=" command-
line option. For example:

   DDNC32 /J=A1234.Job
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The /C command-line option specifies the name of a Dostek DNC Device Configuration
Parameter file (.DCP file extension) that you have created using the Dostek DNC
Configuration application (DConfig). If /C is not specified, a list of existing device
configuration files will be displayed to permit the operator to choose. An asterisk charac-
ter may be used as a wild card. For example, to allow the operator to pick which one of
four identical QT100 lathes to send to, specify "/C=QT100*". DDNC32 will display a list
of all matching device names. 

1.3 Editor

The Dostek DNC Editor application (DEdit32) may be launched for either of two
purposes. If the "/Print" option is specified, DEdit32 will print the specified documents to
the default printer in the background and then exit. Otherwise, DEdit32 will open the
specified files for editing. If no arguments are specified on the command line, DEdit32
will open a new empty document named "Untitled". To specify multiple file names,
separate the names with spaces. For example:

   DEdit32 O1234.TAP "3XR Pump housing.tap"

The following command line options are available for background printing:

/Print Print the specified files. 

/Format=x Specify a page format mode. Choices are:
      P - Portrait mode. 
      L - Landscape mode.
      C - Landscape mode, 2 columns.

/Wrap Wrap long lines onto the next line.

/Nowrap Do not wrap long lines onto the next line. Instead, truncate lines at
the right margin. 

/Page Display the page setup dialog to allow the user to set page format
and margins. 

/Setup Display the printer setup dialog to allow the user to select a printer
and printer options. 

1.4 Configuration

A single file name or the "/Global" command option is permitted on the Dostek DNC/32
Configuration application (DConfig) command line. If the name of a Dostek DNC/32
device configuration file is specified on the command line, it is loaded for editing. If a file
name is not specified, all configuration files in the \Settings folder are loaded for editing.
If the /Global option switch is specified, the "Global settings" form is displayed.
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2 Windows Shortcuts

To modify a Windows shortcut, display the shortcut properties. To display shortcut
properties for a Windows Start Menu item, click the Windows Start button, then click in
the following order: Settings, Taskbar, Start Menu Programs, Advanced. An Explorer
view of the menu structure is displayed. Select a menu item and choose "Properties"
from the File menu. To display shortcut properties for a Windows Desktop item, click on
the item with the right mouse button and choose "Properties" from the context menu. To
display shortcut properties for other Windows shortcuts, including "Send To" menu
items, start Explorer, locate the item, and choose "Properties" from the File menu.

When the Properties form is displayed, choose the "Shortcut" tab and enter command-
line arguments at the end of the Target field (following the application path
specification).

3 Programming Guide 

Dostek DNC/32 applications may be launched from an application program or "macro"
you write in a language that provides a means of executing a Windows "shell" command.
For example, you may use the Microsoft Access "RunApp" action or the Visual Basic for
Applications "Shell" function.

Your program can determine the location of the Dostek DNC/32 application files by
retrieving the "Path" value from the following "key" in the Windows system registry:

My Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Dostek\Dostek DNC32

Sample programs are provided in folder Tools\Launch on the Dostek DNC/32 CD-ROM
to illustrate how to launch a Dostek DNC application from a Visual Basic or Visual C
program. 
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